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COURSE OUTLINE 

 

BIT 2102: ACCOUNTING INFORMATION SYSTEMS 

 

Purpose of the course 

 

To overview the information systems that support the business financial accounting systems of 

an organization and to provide practical skills in accounting information systems development 

and use. 
 
 

 

ACCOUNTING INFORMATION SYSTEMS - TOPICS - DETAILS 
 
 
 

 

I. Overview of accounting information systems 
A. Introduction to Accounting Information Systems 
B. Accounting Methods and Objectives 
C. The accounting process 

 

II. Accounting Transaction Cycles 
A. Introduction to Accounting Cycles 
B. The cycles of business Activities 
C. Transaction Cycles; Financial, Expenditure, conversion and revenue cycles 

 

III. Developing Accounting Systems 
A. Qualities of a successful system 
B. Accounting Information systems development approaches 

 

IV. Setting up A QuickBooks business/company 

A. Creating a Company  
B. Creating customers vendors and items lists 
C. Numbering accounts in QuickBooks 

 
V.  Main QuickBooks features. 

A. QuickBooks working area 
B. QuickBooks customers, vendor and employee centers 
C. Using QuickBooks help 

 

VI. QuickBooks basics 

A. Working with QuickBooks lists 
B. Paying bills 
C. Essential tasks such as Adding an Account 
D. Income and Expense accounts and Balance sheet accounts 
E. Setting up sales tax 
F. Setting up payroll 
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VII. QuickBooks Operating Features 

A. Creating an Estimate 
B. Creating an Invoice 
C. Processing sales and receiving payments 
D. Writing checks and paying employees  
E. Preparing QuickBooks reports such as Trial balance, Trading profit and loss account and 

balance sheet 

 

Main course text 
 

Romney and Steinbart, Accounting Information Systems, 2008, Prentice Hall 

Business Publishing 
 

 

Assessment: Examination - 70%: Coursework - 30% 
 
 

 

Module compiler: John Kamau 
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CHAPTER ONE 

 

OVERVIEW OF ACCOUNTING INFORMATION SYSTEMS 
 

 Learning Objectives   

By the end of this chapter the learner shall be able to; 
 

i. Define an Accounting Information system(AIS) and explain the functions of an AIS 
 

ii. Explain the accounting methods and objectives 
 

iii. Explain the accounting process 
 
 

 

Introduction 
 
 

An Accounting Information System (AIS) is a system that collects, records, stores, and 

processes data to produce information for decision makers. It can: Use advanced 

technology; or be a simple paper-and-pencil system; or, be something in between, 

technology is simply a tool to create, maintain, or improve a system. The functions an 

of AIS are to: 
 

Collect and store data about events, resources, and agents.  
 

Transform that data into information that management can use to 

make decisions about events, resources, and agents. 
 

Provide adequate controls to ensure that the entity’s resources (including data) 

are available when needed, Accurate and reliable 

 

The study of accounting information systems analyzes how events affecting an 

organization are recorded, summarized, and reported. These events are recorded 

using that organization’s system of human and computer resources, summarized using 

accounting methods and objectives, and reported as information to interested persons 

both within and outside of the organization. Accounting information systems exist in 

many forms of organizations, whether proprietorships, partnerships, corporations, 

nonprofit foundations, or households. While the complexity of each accounting 

information system differs, each is similar in three important ways: Each contains a 
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similar structure (of human and computer resources), similar processes (the use 

of accounting methods), and similar purposes (to provide information). 

 

1.1 Accounting Methods and Objectives 

 

All accounting information systems record, process, and report events using 

accounting methods to achieve accounting objectives. These objectives determine the 

system’s scope, which in turn determines the nature of the events and the method of 

accounting. However, all systems record events in money and use the same 

conceptual accounting process. 

 

For the publicly held corporation, the accounting information system’s scope must 

comply with generally accepted accounting principles (GAAP). GAAP is necessary to 

produce financial statements intended for parties external to the organization. With 

‖GAAR any event that has a determinable monetary impact on the organization must be 

recognized as an accounting transaction. A system whose objective is to record, 

process, and report past transactions as financial statements in accordance with GAAP 

is a financial accounting information system. A Usually the scope of an orga.nization’s 

system for processing data is broader than & that required by GAAP. For example, 

when an accounting system includes budgetary forecasts, it recognizes future 

transactions and estimates their monetary impact. Whether short-term annual budgets 

or long-term ones, budgets provide vital financial information for managing the 

organization. Budgeting and other such accounting systems intended primarily for use 

within the organization constitute managerial accounting information systems. Both the 

financial and the managerial systems are components of the organization’s 

management information system (MIS). The MIS is the combination of people, 

procedures, and machines intended to provide information for management decision 

making. It recognizes events beyond those of a purely financial nature. 
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1.2 The Accounting Process 

 

The accounting process begins when an economic event is recognized by an accounting 

information system, which records the economic event as an accounting transaction. 

This module illustrates how the system’s human and computer components process a 

transaction. 
 

For financial accounting information systems, the activities that process a 

transaction constitute the accounting cycle. Conceptually, the accounting cycle 

consists of the following six steps. 
 

Journalize. The first step in the accounting cycle, journalizing is recording the 

transaction. Someone analyzes the event, determines the accounts it affects, identifies 

whether each account is debited or credited, and enters the transaction 

chronologically in a journal processing. 
 

Common special journals include the cash receipts journal, the cash disbursements 

journal, the payroll journal, and the sales journal. Each organization has a chart of 

accounts, which is a list of all account titles maintained in the accounting system. In 

journalizing an event, the accountant must choose accounts from this list. An analyst 

establishes this list at the time the accounting information systems are created. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Post. In posting, the second step, an accounting information system transfers journal 

entries to ledgers. A ledger is a summary, by account, of all transactions affecting that 

account. Thus, after posting, transactions are recorded by account rather than in 

chronological sequence. This step makes it possible to summarize the effects of all the 

events affecting the organization. The Illustration below shows a page from a manual 

system’s ledger. Most organizations also use subsidiary ledgers, which contain detailed 
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information explaining the general ledger’s control account total. Common subsidiary 

ledgers include the accounts payable subsidiary ledger, the property ledger, among 

others. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Prepare a Trial Balance. This is step three in the accounting cycle. During an 

accounting period, accounting information systems journalize and post a large 

number of transactions. Prior to producing accounting reports, the system 

summarizes the effect of all the events in a trial balance. 

 

 

Prepare Adjusting Entries. The fourth step in the accounting cycle is the preparation 

of adjusting entries. Sometimes accountants make these journal entries at the end of a 

reporting period to match the expenses of the period with the revenues generated by 

them. Other adjusting entries correct previous errors in journalizing transactions. An 

accountant or bookkeeper prepares adjusting entries, records them in the journal, and 

posts them to the ledger. These alter the account balances shown in the trial balance. 

 

 

Prepare Adjusting Entries. The fourth step in the accounting cycle is the preparation 

of adjusting entries. Sometimes accountants make these journal entries at the end of a 

reporting period to match the expenses of the period with the revenues generated by 

them. Other adjusting entries correct previous errors in journalizing transactions. An 
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accountant or bookkeeper prepares adjusting entries, records them in the journal, and 

posts them to the ledger. These alter the account balances shown in the trial balance. 
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Chapter Review Questions 
 

1. How does a transaction differ from an event?? 
 

2. Why is it important to understand both the process and the technology associated 

with accounting information systems? 
 

3. Explain the six steps that constitute the accounting cycle 
 

Further reading 
 

Romney and Steinbart, Accounting Information Systems, 2008, Prentice Hall 

Business Publishing 
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CHAPTER TWO 

 

ACCOUNTING TRANSACTION CYCLES 
 

 Learning Objectives  
By the end of this chapter the learner shall be able to; 

 

i. Explain the relevance of accounting cycles in business organizations today 
 

ii. Explain the economic activities engaged by organizations 
 

iii. Explain the concept of transaction cycles such as Financial, Expenditure, 

conversion and revenue cycles. 

 
 
 

2.1 Introduction to accounting cycles 

 

This chapter will describe the technology that accounting information systems use and 

the information system controls that prevent and detect errors and threats to these 

systems. To make it easier to under- my stand these procedures, they are structured 

by accounting transaction cycle. Different accountants describe transaction cycles in 

different ways. Transaction cycles emphasize the continuous nature of all business and 

accounting processes. Transaction cycles demonstrate how events early in a 

transaction cycle affect events and records later in the cycle. A weakness in internal 

control affecting a transaction may mean that records created later in that same cycle 

are misstated. 

 

Accounting systems are designed to record summarize, and report the results of 

economic events for a wide range of organizations. Even though businesses differ in 

their operations, all of them engage in a cycle of business activities. Each activity has 

certain economic events common to most; these economic events produce 

accounting transactions that must be processed by the accounting system. 
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2.2 The cycles of Business Activities 
 

As mentioned earlier all businesses engage in a cycle of business activities that are 

common to most businesses. These activities are; Capital investment, input 

acquisition, conversion and sales. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Capital Investment. The cycle of business activities begins when capital is invested in 

a business. Generally accepted accounting principles (GAAP) require recognizing the 

business as an entity separate from the sources of this capital. These sources may be 

the owners of the business, or they may be creditors. If the source is the owners, the 

investment is owners’ equity. If the source is creditors, the investment is either long-

term debt or current liabilities. In many businesses, most of the capital is used to 

purchase long-term productive assets. The business uses the productive assets to 

increase its capital. Periodically, the business reports the results of its operations to the 

sources of its capital. 

 

Capital investment comprises two significant economic events: raising capital and using 

capital to acquire productive assets. Another event that occurs during this activity is not 

economic in the sense of the other two: Periodically the business reports to its sources 

of capital. This is necessary to maintain those sources when additional capital is 

needed later. 

 

Input Acquisition. The second component of the cycle of business activities is the 

acquisition of materials and overhead items such as supplies. These inputs are used to 

 

14 



increase the capital of the business. The exact way in which they are used is not 

important at this point; they are used differently for different businesses. Most 

organizations operate on credit—that is, when a business purchases inputs, it receives 

the inputs in return for a promise to pay for them. The business records an obligation to 

pay and pays for them at a later date. So, the activity of input acquisition has these 

four economic events: ordering of inputs, receiving them, recording an obligation to pay 

for them, and paying for them. 

 

Conversion. The next step in the cycle of activities is the conversion of inputs into 

goods or services. The business sells these to increase its capital. The conversion 

process is different for different businesses. Manufacturing companies buy raw material 

inventories, apply labor and overhead to them, and produce an output different from 

the material purchased. Service companies convert inputs that are predominantly labor 

into outputs in the form of services. 

 

In contrast, the conversion process of merchandising companies (retailers and 

wholesalers) uses relatively little labor. These organizations purchase inventories of 

goods, repackage them, and then market them. All three businesses use inventories of 

supplies in their conversion processes. One economic event taking place during 

conversion is the consumption of labor materials, and overhead to produce a salable 

product or service. 

 

Sales. The final component in the cycle of basic business activities is the sale of the 

goods or services that were outputs of the conversion process. When these are sold at 

profit, the capital investment of the business increases. Additional cash is available for 

reinvestment, or for making payments to the sources of capital in the form of dividends 

and interest. By providing a source of additional capital, the sales component 

completes the cycle of business activities. The sale of goods or services consists of four 

economic events: receiving a customer order, delivering goods to the customer, 

requesting payment for the goods, and receiving payment. 
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Summary  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Normal business operation consists of a series of economic events. This series results 

from the cycle of business activities that describes how all accounting entities operate. 

An accounting system records economic events in the form of accounting transactions, 

summarizes those transactions, and reports them in some useful way. Thus, you can 

consider business activities as cycles of accounting transactions. In fact, the study of 

transaction cycles is a convenient way to understand how most accounting systems 

work. 

 

2.3 Transaction Cycles 
 

A transaction cycle is a set of accounting transactions that occur in a normal sequence. 

They record the economic events of a component in the cycle of business activities. For 

example, a sales transaction is normally followed by a shipping transaction, a billing 

transaction, and a cash receipts transaction. These constitute a cycle. 

 

The four accounting transaction cycles are; the financial cycle, the expenditure cycle, 

the conversion cycle, and the revenue cycle. 
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Financial Cycle. The financial cycle consists of those accounting transactions that record 

the acquisition of capital from owners and creditors, the use of that capital to acquire 

productive assets, and the reporting to owners and creditors on how it is used. 

 

The two significant economic events in the financial cycle are raising capital and using 

that capital to acquire property, plant, and equipment. A third event—not really an 

economic one—is periodic reporting to the sources of capital. The basic financial 

statements provide periodic reporting. These statements include the balance sheet, the 

income statement, and the statement of cash flows. The summaries in these 

statements come from the general ledger. Periodic reporting to the sources of capital 

enables a business to raise additional capital. For this reason, you can view the series 

of transactions as a cycle. 

 

The three accounting application systems that record the events in the financial cycle 

are the property the journal entry, and the financial reporting systems. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Expenditure Cycle. The expenditure cycle consists of those transactions incurred to 

acquire material and overhead items for the conversion process of the business. This 

processes transactions representing the following economic events: requesting the 

items, receiving the items, recording the obligation to pay for the items, and paying 

for them. 
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Most businesses use a purchasing department to acquire materials and supplies. A 

purchasing agent orders material from a vendor, who ships the material and mails an 

invoice. The business uses the invoice to record the payable and later pays the vendor. 

When the vendor is paid according to the terms of the sale, the vendor again sells items 

to the business. This causes the sequence of transactions to form a cycle. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Revenue Cycle. The revenue cycle includes the accounting transactions that record 

the generation of revenue from the outputs of the conversion process. As mentioned 

earlier, these four economic events generate revenue: receiving an order from a 

customer, delivering goods or services to the customer, requesting payment from the 

customer, and receiving the payment. Whenever companies sell goods or services on 

credit, each of these events produces a transaction. Each transaction may occur at 

separate times. If the sale is a cash sale, then ordering, delivery, request, and payment 

occur at the same time. In this case, accounting systems ordinarily record these four 

events with one transaction. When a customer pays and the accounting system records 

the cash receipt, the business is willing to sell again to the customer. This causes the 

cycle of transactions to repeat. 
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Conversion Cycle. The conversion cycle contains those transactions incurred when 

inputs are converted into salable goods or services. One economic event exists in the 

conversion cycle. Materials, labor, and overhead are consumed in the conversion 

process. In manufacturing and service companies, either actual or standard material 

and labor costs are recorded in a cost ledger as conversion occurs. Overhead costs are 

allocated in the cost ledger, usually based on the amount of labor used. These costs 

become associated with the products and are matched with revenue when the products 

are sold. 
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In merchandising companies, costs of conversion are recorded when incurred and 

matched against revenue in the same period. Depending on the type of organization, 

the conversion cycle contains either two or three application systems. Manufacturing 

and service companies use the cost accounting system to record material, labor, and 

overhead costs. All types of organizations use the payroll system. It ensures that 

employees are paid for their labor. Manufacturing and merchandising companies use the 

inventory system to maintain records of inventory on hand. 

 

In merchandising and manufacturing companies, the systems of the conversion cycle 

provide interfaces between the expenditure and revenue cycles. Because it contains 

only one event, the conversion cycle cannot be represented as a circle as can the 

other cycles. 
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Chapter Review Questions 
 

1. What are the components of the cycle of the business activities? 
 

2. What is a transaction cycle? 
 

3. How can the transaction cycle differ significantly between different businesses, even if 

they are in the same business? 

 

Romney and Steinbart, Accounting Information Systems, 2008, Prentice Hall 

Business Publishing 
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CHAPTER THREE 

 

DEVELOPING ACCOUNTING SYSTEMS 
 

 Learning Objectives   
By the end of this chapter the learner shall be able to; 

 

i. Explain the alternative methods for creating accounting information systems 
ii. Explain the qualities of a successful information system. 

iii. Explain the phases that make up the system development life cycle. 
iv. Explain the alternative methods for developing information systems. 

 
 

 

Introduction 

 

Accountants commonly apply the systems approach in the development of new 

information systems. Many organizations implement the systems approach in a formal 

process called the system development life cycle. Accountants have been creating 

accounting systems for hundreds of years; the double entry system originated in Italy 

before Columbus discovered America. But the relatively recent adoption of computer 

technology in accounting has forced accountants to be more attentive to the methods 

used in developing accounting systems. 

 

The issues addressed in this chapter are; how can one avoid participating in a failure? 
 

Which steps are necessary to successfully implement an accounting system? 

 

3.1 The qualities of a successful system 
 

No accounting information system is completely successful or totally unsuccessful. In 

this context, success is a relative quality: A system is successful if it achieves most of 

the goals set out for it. In general, an accounting information system is successful if it 

achieves four objectives. First, it should produce correct and timely information. 
 

Second, it should be developed within a reasonable amount of time. Third, the system 

should meet the organization’s needs for information. And finally, users should be 
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satisfied with it. These qualities, and some methods of achieving them, are summarized 

below. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3.2 Accounting Information systems development approaches 
 

A number of approaches could be used in developing accounting information systems 
as discussed below; 
 

Systems Development Life Cycle 
 

The Systems Life Cycle (SLC) is a type of methodology used to describe the process 
for building information systems, intended to develop information systems in a very 
deliberate, structured and methodical way, reiterating each stage of the life cycle. 
 

The stages of SDLC are; 

 

Project planning, feasibility study: Establishes a high-level view of 
the intended project and determines its goals.  

 

Systems analysis, requirements definition: Defines project goals into 
defined functions and operation of the intended application. Analyzes end-
user information needs.  

 

Systems design: Describes desired features and operations in detail, 
including screen layouts, business rules, process diagrams, pseudocode and 
other documentation.  

 

Implementation: The real code is written here.  
 

Integration and testing: Brings all the pieces together into a special testing 
environment, then checks for errors, bugs and interoperability.  
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Acceptance, installation, deployment: The final stage of initial development, 

where the software is put into production and runs actual business. 
 
 

Maintenance: What happens during the rest of the software's life: changes, 
correction, additions, moves to a different computing platform and more. This, 
the least glamorous and perhaps most important step of all, goes on seemingly 
forever.  

 

Rapid application development 

 

Rapid application development (RAD) is a software development methodology that uses 

minimal planning in favor of rapid prototyping. 

 

In rapid application development, structured techniques and prototyping are especially 

used to define users' requirements and to design the final system. The development 

process starts with the development of preliminary data models and business process 

models using structured techniques. In the next stage, requirements are verified using 

prototyping, eventually to refine the data and process models. These stages are repeated 

iteratively; further development results in "a combined business requirements and 

technical design statement to be used for constructing new systems". 

 

Object-oriented Aprroach 
 
Object-oriented programming (OOP) is a programming paradigm using "objects" – data 

structures consisting of data fields and methods together with their interactions – to 

design applications and computer programs. Programming techniques may include 

features such as data abstraction, encapsulation, messaging, modularity, polymorphism, 

and inheritance. Many modern programming languages now support OOP. 
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Chapter Review Questions 
 

1. Explain what is meant by a successful information system. 
 

2. What can be done to gain user acceptance of a new system? 
 

3. Explain the different approaches that could be used in developing accounting 

information systems. 
 

4. What are the reasons for initiating systems analysis within an organization? 
 
 

 

Romney and Steinbart, Accounting Information Systems, 2008, Prentice Hall 

Business Publishing 
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CHAPTER FOUR 

 

SETTING UP A QUICKBOOKS BUSINESS 
 

 Learning Objectives   
By the end of this chapter the learner shall be able to; 

 

i. Create a company in QuickBooks 
ii. Review chart of Accounts 

iii. Create customers vendors and items lists 
iv. Number accounts in QuickBooks 

 
 

 

4.1 Getting started Checklist  
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4.2 Creating your company file 
 

To create your company file: 
 

➊ Start QuickBooks by double-clicking the QuickBooks icon on the desktop or clicking 
 

the Windows Start button and then clicking QuickBooks from the Programs group. 
 

➋ Click Create a new company file, or go to the File menu and click New Company. 
 
➌ The Welcome screen for the EasyStep Interview opens. Click Start Interview. 
 

Note: We recommend that you do not skip the interview process. The more information 

you enter with the EasyStep Interview, the more accurate your company file will be 

when you begin to use QuickBooks for your business. However, if you are an 

experienced QuickBooks user and prefer to create your company file manually, you can 

skip the EasyStep Interview by clicking Skip Interview on the EasyStep Interview 

Welcome screen. You will be prompted to enter some basic company information and to 

save the company file. 
 

➍ Follow the onscreen instructions and complete the interview. 
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Completing your company setup 
 

After you’ve created your company file, you can begin using QuickBooks to run your 

business. But before you do, we recommend that you review the information in this 

section to make sure your company file is properly set up and that your data is 

complete. 
 

This section describes some additional tasks you might need to do as you begin using 

QuickBooks. Depending on how much information you entered during the EasyStep 

Interview, some of these tasks might not apply to you. 

 

 

Enter your company information 
 

Do this task if you did not enter this information in the EasyStep Interview. 
 

To enter the contact and legal information for your company, go to the Company menu 

and click Company Information. To learn more about each of the fields and where the 

information you enter will be used in QuickBooks, click the Help button. 

 

 

Review your Chart of Accounts 
 

If you used the EasyStep Interview, a chart of accounts based on your type of business 

was set up for you. Review the chart of accounts to be sure it accurately reflects the 

accounts you need to run your business. You can change account names and edit, 

delete, or add accounts as necessary. For example, you will need to add any business-

related bank, credit card, or loan accounts. To view your Chart of Accounts, go to the 

Lists menu and click Chart of Accounts. 

 

 

Numbering your accounts 
 

Some businesses prefer to organize their accounts by number. Adding numbers can 

help you identify the type of accounts, thereby speeding up your account selection on 

various forms. You might want to develop and follow a consistent account naming and 

numbering convention. For example: 
 

10000-19999 - Assets 
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20000-29999 - Liabilities 
 

30000-39999 - Equity 
 

40000-49999 - Income 
 

50000-59999 - Cost of Goods Sold 
 

60000-69999 - Expenses (or Operating Expenses) 
 

70000-79999 - Other Income (not related to daily activity) 
 

80000-89999 - Other Expenses (not related to daily activity) 
 

If you want to use numbers to identify your accounts, you need to turn on this 

preference in QuickBooks, as follows. 
 

➊ Go to the Edit menu and click Preferences. 
 

➋ In the Preferences window, click Accounting in the list on the left. 
 
➌ Click Company Preferences. 
 
➍ Select the Use account numbers checkbox. 
 
➎ Click OK. 
 
 

4.3 Creating your customer and vendor list 
 

Create your customer, vendor, and items lists 
 

To bill customers and pay your bills with QuickBooks, you must update your customer, 

vendor, and item lists so that they accurately reflect your business. Instructions for 

setting up these lists are provided in the adding vendors and customers section: You 

can choose to enter this information all at once, or you can enter it as you work, using 

the Quick Add feature. 
 

Enter historical transactions 
 

If your start date is before today’s date, you’ll need to enter past transactions from the 

start date to today. This ensures that your QuickBooks records are completely up-to-

date and your reports will be accurate. Enter historical transactions in chronological 

order. For example, QuickBooks won’t know how to credit a customer payment unless 

you’ve previously recorded the invoice to that customer. The most efficient way to enter 

historical transactions is in the account register. 
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Note: Entering historical transactions is especially important if customers don’t pay you 

at the time they receive goods or services. If you don’t enter historical transactions 

early on, it’s hard to track and collect late customer payments. Intuit recommends that 

you enter your transactions in this order (verify with accountant): 
 

• Invoices you’ve sent out since your start date 
 
• Purchase orders you’ve issued since your start date that you haven’t received in full 
 
• Cash or checks you’ve received since your start date 
 
• Bills you’ve received since your start date 
 
• Bills you’ve paid since your start date 
 
• Deposits you’ve made to any of your accounts since your start date 
 
• Any other checks you’ve written (for things other than bills) since your start date 
 
• Employee year-to-date information paid from January 1 through your start date 
 
• Payroll liabilities owed at the time of your start date (for manual payroll and tracking 

payroll transactions only) 
 
Note: If you don’t have time to enter all your historical transactions right away, don’t 

worry. You don’t need to enter all your past transactions before you start using 
 
QuickBooks for new transactions. Enter new transactions as they occur. Then catch up 

with historical transactions when you can. Remember, though, that your account 

balances will be incorrect (and your reports may be wrong) until you enter all the past 

transactions. 

 

 

Complete your bank account information 
 

After you’ve entered your historical transactions, your account registers will contain 

entries reflecting bills you’ve paid, checks and paychecks you’ve written, and deposits 

you’ve received. To make your account registers complete, you must also enter these 

transactions: 
 

• Checks or other charges that happened before your start date but didn’t appear on 

statements before your start date (i.e., didn’t clear) 
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• Other checks you wrote after your start date that were not for bills or accounts 

payable (for example, credit card payments) 24 
 
• Deposits you made after your start date that were not customer deposits 
 
• Deposits you made before your start date but that didn’t appear on statements before 

your start date 
 
• Bank charges and fees 
 
• Interest paid on your account 
 

Refer to the in-product Help for step-by-step instructions on how to enter these 

transactions to make your account registers accurate. 

 

 

Backing up your company file 
 

The QuickBooks backup file is a compressed version of your QuickBooks company file 

that contains all transactions through the date the company backup was made. A 

backup file provides insurance against accidental data loss and can be used to restore 

your data. QuickBooks backups have a .qbb extension and cannot be opened directly. 

QuickBooks provides several backup options for securing your data: 
 

• Standard backup 
 
• Portable Company File 
 

To use one of the backup options, go to the File menu and click Save Copy or Backup. 

To restore your backup, go to the File menu and click Open or Restore Company. To 

learn more about backing up your company file, refer to the in-product Help. 
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Chapter Review Questions 
 

1. Explain how you could create a new company file in QuickBooks? 
 

2. Explain how you could create new customers and vendors 

 

Quick books learning centre. 
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CHAPTER FIVE 

 

MAIN QUICKBOOKS FEATURES 
 

 Learning Objectives   

By the end of this chapter the learner shall be able to; 
 

i. The use the QuickBooks work area 
ii. Find data in QuickBooks centers 

iii. Use customer centre, vendor centre and employee centre 

 

5.1 Getting Around QuickBooks 
 

The QuickBooks work area, shown in Figure 2, is designed to enable you to complete 

tasks quickly. QuickBooks provides several ways for you to work; choose the method 

that works best for you 
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Using the Home page to move around in QuickBooks 
 

When you open a company file in QuickBooks, the Home page is displayed 

automatically. The QuickBooks Home page provides a big picture of how all your 

essential business tasks fit together. Tasks are organized into logical categories 

(Customers, Vendors, Employees, Company, and Banking) with workflow arrows to help 

you learn how tasks relate to each other and to help you decide what to do next. 
 

Note: The workflow arrows indicate a logical progression of business tasks in 

QuickBooks. However, these arrows do not restrict you from doing tasks in a different 

order, or an order that works better for your business needs. To start a task, simply 

click the icon for the task you want to do. For example, to create an invoice, click the 

Invoices icon. To return to the Home page, click the Home button on the navigation 

bar. The Home page also provides a quick glance about the state of your business. You 

can see your current account balances, updated automatically as you do work in 

QuickBooks, in the Account Balances list. The Home page you see has been customized 

to display only those tasks and features that you use, based on the questions you 

answer in the EasyStep Interview. Functions you don’t need won’t clutter your 

workspace. However, to add these functions later, you can turn them on in preferences. 

Go to the Edit menu and click Preferences. Click the Desktop View option and then click 

the Company Preferences tab. If you’re a new business owner or new to QuickBooks, 

the QuickBooks Coach will walk you through the business flows you see on your Home 

page. The QuickBooks Coach uses spotlights and tips to explain each step in your 

workflow. Turn coach tips on and then mouse over and click the Coach icons ( ) to see 

tips and spotlights. 

 

5.2 Finding your data in QuickBooks centers 
 

QuickBooks includes Customer, Vendor, and Employee Centers where you can view and 

manage all of your customer, vendor, and employee information and transactions. You 

can go to one of the QuickBooks Centers by clicking the appropriate button in the 

navigation bar (on the left side of the toolbar). 
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Customer Center 
 

The Customer Center, shown in Figure 3, is a lens into all your customer information. 

Without having to sift through multiple screens, you can view a list of all your 

customers and see pertinent information for each of them. Click on a customer’s name 

and you’ll immediately see all the activity you’ve had with them as well as their 

pertinent contact information (phone number, fax number, and payment terms). You 

can use the Customer Center to find out how much money a specific customer owes 

you or to view a list of all your customers with open balances. You can also look at all 

your customer transactions (estimates, sales orders, invoices, credit memos, refunds, 

etc.) across all of your customer in the Transactions list rather than having to run 

separate reports. 
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Vendor Center 
 

The Vendor Center gives you a complete picture of where your money is going. From 

one screen, you can see all your vendors and exactly what you owe them. Simply click 

a vendor’s name to view your entire history with that vendor. You no longer need to 

run separate reports to see exactly how much business you’re doing with each 

individual vendor. And, you can sort your bills by due date so you can stay on top of 

your finances. If you need to talk to a vendor, click their name and you’ll see all their 

contact information. If a vendor calls you to follow up on a late payment, you can 

quickly look up the bill and see when you paid it and what the check number was. 
 

Employee Center 
 

From the Employee Center, you can see exactly what you’re paying each employee. 

Simply click an employee’s name to view that person’s payroll history. And if you need 

to get in touch with an employee, their contact information is right in front of you. 

 

 

Payroll Center 
 

If you subscribe to one of the QuickBooks Payroll services (additional fees apply), the 

Employee Center includes a Payroll Center. Use the Payroll Center to manage your 

payroll and payroll compliance.1 The Payroll Center is the hub for managing all payroll 

activities. The Payroll Center reminds you of important payroll dates so you pay your 

employees, pay your payroll liabilities, and file forms on time. To check out the Payroll 

Center, click the Employee Center icon on the navigation bar and then click the Payroll 

tab. 

 

5.3 Using in-product Help 
 

QuickBooks in-product Help provides background information and instructions for doing 

QuickBooks tasks. You can access the Help content and features in several ways. To 

use in-product Help, go to the Help menu and click QuickBooks Help. 
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Viewing Help for a window you have open 
 

If you are unsure how to use a particular QuickBooks window, press the F1 key on your 

keyboard. To get help. (You can also click the Help button in the window, if one is 

present.) 
 

These Help topics provide answers to questions such as: 
 

• What can I use this form for? 
 
• What does this button do? 
 
• What kind of information is displayed in this column? 
 
• What happens when I select this option? 
 
• How do I complete the task? 
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Chapter Review Questions 
 

1. Explain how you could find data in the QuickBooks centers. 
 

2. What is the importance of the vendor centre? 
 

Quick books learning centre in the QuickBooks software. 
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CHAPTER SIX 

 

QUICKBOOKS BASICS 
 

 Learning Objectives   

By the end of this chapter the learner shall be able to; 
 

i. Work with QuickBooks lists 
ii. Write checks and pay bills 

iii. Add different types of accounts in QuickBooks such as the income and the expense 
 
 

 

To take full advantage of QuickBooks, there are some important concepts you need 

to understand. 

 

6.1 Working with QuickBooks lists 
 

Lists are one of the important building blocks that make QuickBooks so powerful and 

efficient. QuickBooks uses list information to fill out most QuickBooks forms. For 

example, to create an invoice, you choose the customer name from your Customers & 

Jobs list. QuickBooks automatically enters the customer information on the form for 

you. This saves you time and prevents typing errors. You can also change the 

information directly on the form as needed. Lists are easy to set up in QuickBooks, but 

do require careful planning. Depending on the type of list you want to use, you can get 

to the list in one of two ways: 
 

• QuickBooks Centers: Your Customers & Jobs, Vendors, and Employees lists are 

available in the Customer, Vendor, and Employee Center, respectively. Click the 

appropriate QuickBooks Center button on the navigation bar to go to a QuickBooks 

Center. 
 
• List windows: Other lists, such as the Chart of Accounts and Item List, appear in 

separate windows. To view one of these lists, click the Lists menu and then click the list 

you want. To enter information in these lists, use the menu button at the bottom of the 

list to add, edit, or delete list items. The menu also provides access to common features 

associated with the list. 
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The more detail you enter for each list item, the more information QuickBooks can use 

to pre-populate forms, track financial data, and display useful reports about your 

business. Another advantage of lists is that common tasks like adding list entries, 

editing list information, and deleting list entries are performed the same way. 
 

Figure 4 illustrates how QuickBooks uses list information across multiple windows and 

tasks to simplify data entry and to give you a complete picture of how your business is 

doing. 

 

6.2 Writing checks versus paying bills 
 

In QuickBooks, you can manage your bills and payments in two ways: 
 

Write checks to pay bills now. Use the Write Checks window and assign the 

amounts to appropriate expense accounts. This method is recommended when you 

don’t receive a bill, such as when you go to the store and write a check and then you 

need to record that expense in QuickBooks. You can also use Write Checks to pay a bill 

as soon as you receive it, as long as you don’t need to track the bill. 

Enter bills when you receive them and pay them later. 
 

Use the Enter Bills window to enter bills when you receive them. Then use the Pay Bills 

window to pay bills when they are due. You can set up QuickBooks to remind you to 

pay bills when they are due. Using this method, you keep your money in your business 

for as long as possible. You might still use a check to pay the bill, but this method 

enables you to track how much money you owe. And at any time, you can run reports 

to analyze unpaid bills for information such as which vendors you owe money. 
 

Note: Do not simply write a check in the Write Checks window to pay bills that you 

entered in the Enter Bills window or the accounts payable registers. 
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6.3 QuickBooks Essential Tasks 
 

Adding an Account 
 

When you set up your company file, QuickBooks sets up certain accounts for you 

automatically. However, as your business grows or changes, you might need to add 

new accounts to your chart of accounts to better organize your finances. Or, you might 

need an account that was not provided during setup. For example, you might want to 

create expense accounts to track office supply purchases separately from advertising 

costs. To add an account: 
 

➊ Go to the Lists menu and click Chart of Accounts. 
 
➋ Click the Account button and then click New. 
 
➌ In the Add New Account: Select Account Type window, select the type of account 
 

you want to create and then click Continue. 
 

➍ Enter the account’s name in the Account Name field. This name will appear on your 
 

company financial statements. 
 

➎ If  you  want  to  make  this  account  a subaccount of  another  account,  select the 
 

Subaccount of checkbox. From the drop-down list, click the account that will be 

the higher-level account for this subaccount. 
 

➏ (Optional) Enter a short description, note, bank account number, or credit card 
 

number, depending on the type of account you are adding. 
 

➐ For income and expense accounts. From the Tax-Line Mapping drop-down list, click 
 

the appropriate tax line or <Not tax-related>. 
 

➑ For  balance  sheet  accounts.  Enter  an  opening  balance  based  on  the  account’s 
 

balance as of your QuickBooks start date. Generally, you should enter any balance 

sheet balances as of the day before your start date. That way it’s all exactly correct at 

the opening of your start date. If you’re putting money into the account with a 

transaction, do not use the opening balance field, since this will create an additional 

transaction. If you’re not sure of the balance, you can leave the field blank and enter 

the information later. Click OK when finished. 
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➒ Click Save & Close or Save & New to add another account.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Why Use Subaccounts? 
 

When you need more detail about what’s going on in an account, you can divide the 

account into one or more subaccounts. Subaccounts let you track several related types of 

income or expenses independently yet keep them all under the ―umbrella‖ of a single 

parent account. Subaccounts appear indented immediately below their parent account in 

your chart of accounts. If you create subaccounts, it’s best not to post anything to the 

―parent‖ account For example, if your business has substantial advertising 
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expenses, you might decide to divide your Advertising expense account into several 

subaccounts, such as Newspaper Ads, Signs, Yellow Pages Listing, and Direct Mailings. 
 

What type of account should I use? 
 

There are two main types of accounts in the QuickBooks chart of accounts: 
 

• Income and expense accounts 
 
• Balance sheet accounts 
 
Income and Expense Accounts 
 
Income and expense accounts track the sources of your income and the purpose of 

each expense. When you record transactions in one of your balance sheet accounts, 

you usually assign the amount of the transaction to one or more income or expense 

accounts. For example, not only do you record that you took money out of your 

checking account, but you keep track of what you spent the money on (utilities or office 

supplies). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note: QuickBooks does not display balances for income and expense accounts in the 

Chart of Accounts. To see these balances, go to the Reports menu, click Report Center, 

and then click the Company & Financial category. You can also select the income or 

expense account in the chart of accounts and click QuickReport. 
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Balance Sheet Accounts 
 

QuickBooks provides 10 types of balance sheet accounts to choose from as you create 

and add to your Chart of Accounts. Use the type of account that best describes the type 

of data you are tracking. 
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6.4 Adding Customers Vendors and other accounts 

Adding Customers 
 

Customers are the lifeline of your business. By entering detailed information in 

QuickBooks about the people and companies to whom you sell your products and 

services, you can personalize their bills, send invoices easily, and quickly view the status 

of their accounts. You can add new customers at any time. 
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To add a customer: 
 

➊ Click the Customer Center icon at the top of the QuickBooks window. 
 
➋ Click New Customer & Job and then click New Customer. 
 
➌ On the Address Info tab, enter all the data that you have about the customer, 
 

including their name, Bill to and Ship to addresses, and additional contact information. 
 

➍ Complete the Additional Info and Payment Info tabs, as appropriate. 
 

➎ If you want to add additional fields to the form, click Define Fields to customize the 
 

form. 
 

➏ Click OK or Next (if you want to enter another customer). 
 

Adding Vendors 
 

QuickBooks uses the vendor list to hold information about the people and companies 

you buy goods and services from to run your business; for example, this list could 

include the phone company, your office supplies vendor, and your tax board. You can 

add new vendors at any time. 
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To add a vendor: 
 

➊ Click the Vendor Center icon at the top of the QuickBooks window. 
 
➋ Click New Vendor. 
 
➌ On the Address Info tab, enter all the data that you have about the vendor, including 
 

their name, address, and additional contact information. 
 

➍ If you owe this vendor money as of your company’s start date, enter the amount in 
 

the Opening Balance field. 
 

➎ Click the Additional Info tab and complete the form. 
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➏ If you want to add additional fields to the form, click Define Fields to customize the 
 

form. 
 

➐ Click OK or Next (if you want to enter another vendor). 
 
 
 

Adding Items 
 

In QuickBooks, an item is anything that your company buys, sells, or resells to run your 

business. Items are your products, services, and things such as shipping and handling 

charges, discounts, and sales tax. When you choose an item from the Item list, 

QuickBooks fills in a description of the line item and calculates its amount for you. 
 

QuickBooks provides 12 different types of items, described in the table on page 58. 

Some items, such as service or inventory part items, help you record the services and 

products your business sells. Other items, such as the subtotal or discount item, are 

used to perform calculations on the amounts in a sale. 
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To add an item: 
 

➊ Go to the Lists menu and click Item List. 
 

➋ Click Item at the bottom of the list and then click New. 
 

➌ Click the Type drop-down arrow and choose the type of item you want to create (see 
 

table on page 58). 
 

➍ Enter an item name as you want it to appear on purchase and sales forms. 
 

➎ Enter the description that you want to appear on sales forms when you use the 
 

payment item. 
 

➏ In the Rate field, enter the amount you want to charge for the item or leave as zero, 
 

if the rate varies. 
 

➐ In the Account field, choose the account that is associated with this item. (In most 
 

cases, you will assign the item to an income account.) 
 

➑ In the Tax Code list, select the appropriate sales tax code or create a new one. If 

you do not see the Tax Code list, you must turn the tax preference on in the Sales Tax 

area under Edit | Preferences. 

➒ Click OK or Next (if you want to enter another item). QuickBooks provides 12 

different types of items to help you fill out sales and purchase forms quickly. 
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Which Item Type Should I Choose? 
 

QuickBooks provides 12 different types of items to help you fill out sales and purchase 

forms quickly. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Why item types are important 
 

Although you can use items as a quick means of entering data, items fulfill a much 

more important QuickBooks role: to handle the behind-the-scenes accounting. When 

you create an item, you link it to an account; when the item is used on a form, it posts 

an entry to that account and another entry to the appropriate accounts receivable, 

accounts payable, checking, fixed asset, or other account. While items are easy to set 
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up, you should spend some time deciding how they can best work for you before you 

start setting them up and using them. Use your current list of services and products as 

a starting point. Consider how much detail you want on your invoices or statements and 

set up your items with that level of detail in mind. For example, if you are a seamstress 

who creates and sells home accessories, you can set up a single item and charge a flat 

rate for a certain size of couch pillow, or you can break that pillow down further into 

labor and materials. Furthermore, QuickBooks provides many useful reports that break 

information down by the goods or services you purchase and sell. That way, you can 

quickly find out: 
 

• How much income your items bring in 
 

• What you are spending to purchase items 
 

• How well you estimate the cost of items 
 

• How much time you spent on each type of job or item 

 

6.5 Setting up sales tax 
 

Setting Up Your Business | Setting up Sales Tax 
 

Depending on where you do business, you might be required to collect sales tax for the 

products or services you sell. If you collect sales tax, you must pay it to a tax agency 

on a regular schedule. QuickBooks helps automate your sales tax tracking so you can 

keep accurate records about the sales tax you collect and pay. 
 

Important: You must follow the rules and regulations for collecting and paying sales tax 

in your tax district (city, county, state). 
 

Understanding how sales tax works 
 

QuickBooks uses sales tax codes to track the taxable or non-taxable status of both the 

items you sell (products and services) and your customers. If your tax agency requires 

you to report the reasons why particular sales are taxable or non-taxable, the sales tax 

codes that you assign to your items and customers enable you to run reports that 

provide this information for your sales tax return. QuickBooks uses sales tax items to 

calculate and add sales tax charges when you make a taxable sale. When you set up a 
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sales tax item, you assign a sales tax rate to it and associate it with the tax agency to 

which you pay the sales tax. All of the sales tax items you set up are in your Item list. 

Once you’ve set up sales tax, QuickBooks automatically applies the appropriate sales 

tax rate to the sale of your taxable items. 
 

Before you start setting up sales tax 
 

To set up sales tax in QuickBooks, you need to know the following sales tax 

requirements for the locations where you sell your products and services: 
 

• Sales tax rates for each tax district (a city, county, or state that has a sales tax) in 

which you sell. You may have multiple sales tax rates that you need to charge, for 

example, sales tax for both a county and a state. 
 
• Tax agencies to which you pay the collected sales tax for each of those district taxes. 
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Setting up sales tax 
 

Setting up sales tax is a multi-step process, divided into three main parts: 
 

• Part 1: Sales tax payment schedule 
 
• Part 2: Sales tax codes to track taxable status of items and customers 
 
• Part 3: Sales tax items, rates, and tax agencies 
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Part 1: Sales tax payment schedule 
 

In this procedure, you’ll turn on sales tax and then set up information about when you 

need to pay your tax agency. To set up your sales tax payment schedule: 
 

➊ Go to the Edit menu and click Preferences. 
 
➋ Click Sales Tax in the list on the left. 
 
➌ Click the Company Preferences tab. 
 
➍ For the question Do You Charge Sales Tax?, click Yes. 
 
➎ Select when you owe sales tax to the tax agency, as specified by your tax agency. 
 

• Select As of invoice date if your tax agency stipulates that you owe sales tax from the 

moment you write an invoice or make a sale. 
 
• Select Upon receipt of payment if your tax agency stipulates that you owe sales tax 

when you receive the payment from a customer. 
 
Note: This preference overrides the accounting basis you’ve set for your company and 

for your report preferences (i.e., if your report preference is set to ―cash‖ but you 

select ―accrual‖ here, your sales tax reports will be accrual-based). 
 

➏ Select how often you pay sales tax to the tax agency, as specified by your tax 

agency. If you don’t know which time period to choose, check your sales tax license. It 

should indicate the payment schedule that you need to use. 
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6.6 Setting up your Payroll 
 

As an employer, you have specific payroll responsibilities that are required by 

government agencies. These agencies can be federal, state, or local. Some of these 

responsibilities include, but are not limited to, withholding amounts from your 

employees’ compensation to cover income tax, social security, Medicare, and other 

payments. 
 

Choosing a payroll service 
 

To use QuickBooks to manage your payroll, you first need to subscribe to a QuickBooks 

payroll service. QuickBooks’ flexible options ensure that you get the payroll service that 

is right for you. QuickBooks also includes manual payroll features that do not require a 

subscription. Refer to the in-product Help for more information about using manual 

payroll in QuickBooks. Consult with a tax professional or accountant to address all of 

your business’ specific needs. You can learn about all of the QuickBooks payroll 

offerings, including manual payroll through the QuickBooks Payroll Web site. To learn 

about and sign up for a Payroll Service: 

➊ Go to the Employees menu and click Payroll. 
 

➋ Click Learn About Payroll Options. Or, if you are not sure which payroll service is 
 

right for you, contact one of our payroll experts at 1-866-820-6382 to learn more and 

help you choose. 
 

Note: If you choose to sign up for a payroll service, you will be prompted to complete 

the activation process for your service. After you complete your activation, you can set 

up payroll for your business as described in the next section. 
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Setting up payroll 
 

QuickBooks Payroll includes an easy-to-use Payroll Setup wizard that guides you 

through setting up payroll for your business. Payroll Setup helps you set up your 

employees, set up compensation and benefit information, as well as enter any year-to-

date payroll data. You will also be assisted in setting up scheduled payroll groups and 

your payroll liability payment schedule to make managing your payroll easier. 
 

Setting up Employees 
 

To process paychecks and prepare tax documents for your employees, you need to 

enter specific information about each of your employees in QuickBooks. 
 

Note: If you are a QuickBooks Payroll subscriber, you will be prompted to add all of 

your employee information during payroll setup (described on page 69). Use the 

following procedure to edit employee information or to add additional employees at a 

later date. Refer to the Payroll Setup Checklist on page 71 for a list of employee 

information to gather. To set up an employee’s personal information: 

➊ Click the Employee Center icon at the top of the QuickBooks window. 
 
➋ Click New Employee. 
 
➌ On the Personal tab, fill in the form. 
 
➍ Click the Address and Contact tab, fill in the form, and then click OK. 
 
➎ When prompted to set up the employee’s payroll information, click Leave As Is. To 
 

set up an employee’s payroll information: 
 

➊ Click the Employee Center icon at the top of the QuickBooks window. 
 
➋ Click the Employees tab and then double-click the employee’s name. 
 
➌ From the Change tabs drop-down list, click Payroll and Compensation Info. 
 
➍ Fill in the Payroll Info form. 
 
➎ Click the Taxes button. 
 
➏ Click the Federal tab and fill in the form, based on the employee’s W-4 information. 
 

➐ Click the State tab and fill in the form. 

➑ Click OK. 
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Once you’ve set up your employees, refer to ―Paying Employees‖ to learn about paying 

them. 
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Chapter Review Questions 
 

1. Explain how you would create income and expense accounts. 
 

2. Explain the procedure of adding a customer in QuickBooks. 
 

3. . Explain the procedure of adding items in QuickBooks. 

 

Further readings 

 

QuickBooks learning centre in the software. 
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CHAPTER SEVEN 

 

QUICKBOOKS OPERATING FEATURES  

 

Learning Objectives 

 

By the end of this chapter the learner shall be able to; 
 

i. Create an Estimate in QuickBooks 
ii. Create an Invoice  

iii. Enter sales receipts and receive a payment in QuickBooks software and receive 
money from a customer by making a deposit 

iv. Pay a bill and write checks  
v. Prepare different reports such as trial balance, Trading profit and loss account and 

balance sheet 

 

7.1 Creating an Estimate 
 

You can use the estimate form to prepare estimates, bids, quotes, or proposals for your 

customers. You can change the title ―Estimate‖ to anything that suits your business. 

Filling in the estimate is similar to creating an invoice. And when it’s time to bill your 

customer, you can create the invoice directly from the estimate by clicking Create 

Invoice on the estimate’s toolbar. QuickBooks then creates the invoice, with all the 

information from the estimate filled in. Later, you can create reports that compare your 

estimated costs and revenue against your actual costs and revenue to see how accurate 

your estimates are. To create an estimate: 

➊ If necessary, turn on Estimates (described below), if you didn’t do this during the 
 
EasyStep Interview. 
 
➋ Go to the Customers menu and click Create Estimates. 
 
➌ Enter the name of the customer or job. 
 

➍ Select an estimate template from the Template dropdown 

list. ➎ Fill in the estimate form. 
 
➏ Click Print. 
 
❼ Save the estimate. 
 
To turn on the estimates feature: 
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➊ Go to the Edit menu and click Preferences. 
 

➋ Click Jobs & Estimates in the list on the left and then click the Company Preferences 
 

tab. 
 

➌ Click Yes to the question, ―Do You Create Estimates?‖ 
 

➍ To have QuickBooks warn you when you try to record an estimate with the same 
 

number as the existing estimate, select the Warn about duplicate estimates numbers 

checkbox. 
 

➎ If you do progress invoicing: 
 

• Make sure Yes is selected in response to the question, ―Do You Do Progress 

Invoicing?‖ 
 
• Specify whether you want line items that have zero amounts to print on your progress 

invoice 
 
➏ Click OK.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7.2 Creating an Invoice 
 

When your customers don’t pay you in full at the time you provide your service or 

product, or when they pay in advance, you need to track how much they owe you. You 
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can use an invoice to help you keep track of what your customers owe you (or your 

―accounts receivable‖). Invoices list all the details about the sale, including the services 

you’re providing or the products you’re selling (your ―items‖). Invoices also show the 

quantity and price or rate of each item. If you need to make automatic adjustments to 

prices (for example, discounts or markups), invoices will work for you. 
 

Note: If your customers pay in full at the time of purchase, do not create an invoice. 
 

Instead, create a sales receipt, described on page 79. 
 

To create an invoice: 
 

➊ Go to the Customers menu and click Create Invoices. 
 

➋ In the Customer:Job drop-down list, enter a name or click the name of the customer 
 

or job. 
 

➌ Click the Template drop-down arrow and then click the invoice template you want to 
 

use. 
 

➍ Click the Terms drop-down arrow and then click the sales terms that apply to this 
 

customer. 
 

➎ In the lower part of the form, enter each of the items (including the proper quantity) 
 

that the customer has purchased. 
 

➏ Click Print on the toolbar to print the invoice now. Optionally, you can select the To 
 

be printed checkbox to print the form later or the To be e-mailed checkbox to e-mail 

the form later. 
 

➐ Save the invoice. 
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7.3 Entering sales receipts 
 

When your customers pay in full at the time they receive your service or product, you 

don’t need to track how much they owe you. However, you might want to record the 

sale, calculate its sales tax, or print a receipt for the sale. In these cases, you can 

create a sales receipt. Examples of businesses that commonly use sales receipts include 

beauty salons, pet groomers, dry cleaners, and restaurants. 
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Note: If you need to track how much a customer owes you or you do not receive full 

payment at the time of the transaction, do not use a sales receipt. 
 

To enter a sales receipt: 
 

➊ Go to the Customers menu and click Enter Sales Receipts. 
 

➋ Fill in the top part of the form, including the Customer:Job, Date, and Payment 
 
 
 

➌ Click the Template drop-down arrow and then click the sales receipt template you 
 

want to use. 
 

➍ In the bottom part of the form, select or enter the items purchased. 
 
➎ Save the transaction.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7.4 Receiving a Payment 
 

 

When you receive money from a customer, you must receive the payment in 

QuickBooks so QuickBooks can record the transaction and mark the invoice as being 

paid. When you receive a payment, the accounts receivable records are updated, and 

the payment is ready to be deposited into an account. To receive a payment: 
 

➊ Go to the Customers menu and click Receive Payments. 
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➋ Fill in the top portion of the form, including the customer’s name, the payment 
 

amount, payment method, and the date on which the payment was received. 
 

➌ Check the column to the left of the invoice to which you want to apply the payment. 
 

You might be asked to decide how to apply the payment for one of the following 

scenarios: 
 

• Overpayment can become a credit or refund 
 
• Underpayment can be left as is or written off 
 
• Customer has unused credit to be applied 
 
• Customer has available discounts 
 

➍ Choose the appropriate selection and you should see your choices reflected in total 
 

amounts for selected invoices. If the customer has a discount or available credits, you 

can choose how to apply them. 
 

➎ Save the payment.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7.5 Making a Deposit 
 

When you receive a payment from a customer, you can either deposit the payment into 

a bank account immediately, or you can wait until a later time to make the deposit. To 

make a deposit: 
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➊ Go to the Banking menu and click Make Deposits. 
 

➋ In the Payments to Deposit window, select the payments that you want to deposit 
 

and click OK. 
 

➌ In the Make Deposits window, click the Deposit To drop-down arrow and then click 
 

the account to which you want to deposit the funds. 
 

➍ Verify the date and the list of payments to deposit, making updates as necessary. 
 
➎ If you want to receive cash back from this deposit, fill in the Cash Back fields at the 
 

bottom of the form. 
 

➏ If you want to print a deposit slip or deposit summary, click Print. 
 
➐ Save the deposit. 
 

Note: Just because you’ve recorded the deposit in QuickBooks doesn’t mean that you’ve 

actually made the deposit and that the money is available. You still need to physically 

deposit the money at the bank or send an online transfer. 
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7.6 Paying Bills 
 

As you purchase equipment, supplies, products, or services to run your business, you 

will also receive bills that need to be paid. Entering these bills in QuickBooks enables 

you to not only track information about your purchases, but also to pay these bills. 

QuickBooks remembers all of your unpaid bills, enabling you to easily choose the bills 

you want to pay. QuickBooks then writes and saves the checks or credit card charges or 

sends the online banking payment instructions, depending on the payment method you 

choose. 
 

Note: Before paying a bill, be sure you read the section ―Writing checks versus paying 

bills‖ on page 41 to make sure you are using the correct payment method. 
 

To enter a bill: 
 

➊ Go to the Vendors menu and click Enter Bills. 
 

➋ In the Vendor field, choose or enter a new vendor. 
 

Note: If an open purchase order exists for this vendor, you are prompted to receive 

against it. Click Yes to receive against one or more purchase orders; then, in the Open 

Purchase Orders window, click each purchase order that contains items you’ve received 

and are being billed for. 

➌ Specify the Payment Method, Payment Account, and Payment Date. 
 
➍ In the Amount Due field, enter the amount of the bill. 
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➎ Fill in the Date, Ref. No., Terms, and Memo fields as necessary. 
 

➏ For expenses (money you spend to run your business, such as utilities), assign the 
 

bill to one or more expense accounts on the Expenses tab. For items (products or 

services your business buys), edit items that were entered from your purchase order or 

enter new items on the Items tab. 
 

➐ Click Save & Close or Save & New to enter the transaction. To pay a bill: 
 
➊ Go to the Vendors menu and click Pay Bills. 
 
➋ All outstanding bills are displayed. To limit the number of bills displayed, click Due on 
 

or before and then click the due date for the bills you want to display. 
 

➌ Click Pay Selected Bills to complete the transaction.  
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7.7 Writing Checks 
 

You can write a check for any kind of expense that you track with QuickBooks expense 

accounts and for noninventory part, service, and other charge items. If you are using 

inventory or purchase orders (Premier only), you can write checks for inventory part 

items too. 
 

Note: Before writing a check, be sure you read the section ―Writing checks versus 

paying bills‖ on page 41 to make sure you are using the correct payment method. 
 

To write a check: 
 

➊ Go to the Banking menu and click Write Checks. 
 

➋ Click the Bank Account drop-down arrow and then click the account from which you 
 

want to write the check. 
 

➌ Fill in the onscreen check as you would a paper check. 
 

➍ Itemize your expenses (shipping charges, taxes, or other expenses not associated 
 

with any one item) on the Expenses tab. 
 

➎ If you are purchasing items for your inventory, enter the items on the Items tab. 
 
➏ Save the transaction. 
 
 
 

➊ Load the blank check form into the printer. 
 

➋ Go to the Banking menu and click Write Checks. 
 

➌ Click the Find button and search for the check you want to print. 
 
➍ Double-click to view the check you want to print. 
 
➎ Click Print. 
 
➏ In the Print Checks window, choose the options you want and click Print. 
 

Note: To learn how to print multiple checks at the same time, refer to the in-product 

Help. 
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7.8 Issuing Credits or Refunds 
 

Use a credit memo to record a credit when a customer returns items and you’ve already 

recorded an invoice, customer payment, or sales receipt. You can also use a credit 

memo for an overpayment. To enter a credit memo or record a return: 
 

➊ Go to the Customers menu and click Create Credit Memos/Refunds. 
 

➋ In the Customer:Job field, click the customer and job for which you are creating the 
 

credit memo or refund check. 
 

Note: If you have created more than one job for the customer, be sure to assign the 

credit memo to the correct job. You can apply the credit memo only to the same job for 

which it was created. 
 

➌ Click the Template drop-down arrow and then click a template. 
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➍ Enter the items being returned in the line item area. 
 

➎ Describe the reason for the credit and enter the quality and rate, if applicable. 
 
➏ (Optional) Enter a memo for this transaction. 
 

Note: The memo does not print on the credit memo, but it does appear in the Accounts 

Receivable register and in the customer register. 
 

➐ Indicate whether you want to print or e-mail the credit memo to the customer. (You 
 

can choose to do both.) 
 

➑ Save the credit memo. 
 

➒ In the Available Credit window, choose how to use the credit. You can: 
 

• Retain as an available credit 
 
• Give a refund 
 
• Apply it to an invoice 
 

Note: QuickBooks enters a negative amount in your Accounts Receivable register for 

the credit memo. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

7.9 Paying Employees 
 

Paying employees is a big responsibility. You have to keep track of hours, salaries and 

wages, Social Security numbers and dependents, tax rates and forms, vacation and sick 

time, bonuses and advances, as well as company payments to government and private 
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pension plans. QuickBooks provides several features and services to help you manage 

your own payroll quickly and easily. 
 

Note: For information about your payroll options in QuickBooks, go to the Employees 

menu, click Payroll Service Options, and then click Learn About Payroll Options. 
 

To print paychecks: 
 

➊ Go to the Employees menu, click Pay Employees, and then specify if you want to pay 
 

employees using Unscheduled Payroll (generally used to pay bonuses and off-cycle 

checks) or set up Payroll Schedules. 
 

➋ Update the Pay Period Ends date and the Check Date values, as needed. 
 

➌ Click the Bank Account drop-down arrow to choose the account that QuickBooks 
 

uses to record this transaction. 
 

➍ Select the employees you want to pay by clicking in the column to the left of the 
 

employee’s name. 
 

➎ Review the paycheck information in the Enter Payroll information window. 
 

➏ To preview or modify a paycheck, click the employee’s name to open the Preview 
 
 
 

➐ Click Continue. 
 

➑ Review and verify the paycheck information in the Review and Create Paychecks 
 

window. 
 

➒ In the Paycheck Options section, click whether the paychecks should be printed or 
 

handwritten. 
 

❿ Click Create Paychecks. 
 

⓫ In the Confirmation and Next Steps window that appears, click Print Paychecks. Click 
 
Send Payroll to Intuit if you’re sending your payroll to Intuit for processing. 
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7.10 Using Reports 
 

One of QuickBooks’ most robust features is its ability to generate data-rich reports 

about your business. Everything you enter in QuickBooks can be found and generated 

into a report. 
 

QuickBooks comes with dozens of prepared reports that you can run. You can use the 

Report Center to learn about QuickBooks reports and locate the ones that contain the 

information you need. Once you’ve found a report, you can change its date range, 
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customize the way it looks, print a copy of it, export it to Microsoft Excel, or display it 

on your screen. 
 

To find and display the right report: 
 

➊ Click the Report Center icon at the top of the QuickBooks window. 
 

➋ Click a report category from the list on the left. Reports for the selected category are 
 

displayed on the right. 
 

➌ From the report list, you can view a thumbnail picture of the report by moving your 
 

mouse over the thumbnail icon . To learn more about a specific report, click the More... 
 

link to learn about the data and specific ways to customize the report. 
 

➍ When you find the report you need, click its name to view the report.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

How to Use Reports to Find the Information You Want 
 

The QuickBooks Report Center describes all the available reports. Here are 10 common 

questions that people ask and the QuickBooks report you can use to find the answer. 
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Chapter Review Questions 
 

1. Explain the procedure of creating an estimate in QuickBooks software. 
 

2. Explain the different way of paying for a payment in QuickBooks. 
 

3. If a QuickBooks user makes a deposit in the software does the deposit appear in the bank 

account? 

 

For further reading: QuickBooks learning centre in the QuickBooks software. 
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SAMPLE EXAM QUESTIONS 
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